Contents

Documentation Accessibility ........................................................................................................................................... vii

Documentation Feedback ................................................................................................................................................ ix

1 Welcome to Smart View Installation and Configuration ................................................................. 1-1

2 Installing Smart View

   Installation Guidelines ............................................................................................................................................ 2-1
   Installer Language ................................................................................................................................................. 2-1
   Installation and Windows Access Control Settings ......................................................................................... 2-1
   Microsoft .NET Framework Support ................................................................................................................... 2-2
   BiDi Support in Installer ................................................................................................................................... 2-2
   Planning Offline Support .................................................................................................................................. 2-3
   Installing from My Oracle Support or Oracle Technology Network ......................................................... 2-3
   Installing by Autodeployment in EPM System ................................................................................................... 2-4
   Server Setup ..................................................................................................................................................... 2-4
   Client Installation .............................................................................................................................................. 2-6
   Installing from EPM Workspace ......................................................................................................................... 2-7
   Workspace Setup .............................................................................................................................................. 2-7
   Client Installation .............................................................................................................................................. 2-7
   Installing from Oracle BI EE .............................................................................................................................. 2-8
   Configuring the Oracle BI EE Analytics Home Page ......................................................................................... 2-8
   Installing from the Oracle BI EE Analytics Home Page ................................................................................... 2-9
   Running Command Line or Silent Installations ............................................................................................... 2-10
   Downloading Help for Local or Web Server Installation .............................................................................. 2-11
   Uninstalling Smart View .................................................................................................................................. 2-12

3 Administering Extension Installations and Updates

   About Extension Installations and Updates ....................................................................................................... 3-1
   Configuring Manual Extension Updates ........................................................................................................... 3-2
   Manual Update XML Defined ........................................................................................................................... 3-4
Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.
Send feedback on this documentation to: epmdoc_ww@oracle.com

Follow EPM Information Development on these social media sites:
LinkedIn - http://www.linkedin.com/groups?gid=3127051&goback=.gmp_3127051
Twitter - http://twitter.com/hyperionepmInfo
Facebook - http://www.facebook.com/pages/Hyperion-EPM-Info/102682103112642
Google+ - https://plus.google.com/106915048672979407731/#106915048672979407731/posts
YouTube - https://www.youtube.com/user/EvolvingBI
Welcome to Smart View Installation and Configuration

This help includes topics on these subjects:

- Installing Oracle Smart View for Office
- Administering extensions
- Configuring shared connections in an XML file
- Configuring locally-installed help
- Troubleshooting tips
- Limitations

To find information in this help, click Contents or Search in the left frame.
Installing Smart View

Oracle Smart View for Office uses a single installer for 64-bit and 32-bit versions of Microsoft Office, starting with release 11.1.2.5.

Late-breaking information about the Smart View installation is provided in the Oracle Smart View for Office Readme. You should thoroughly review this chapter along with the information in the readme before installing Smart View.

Late-breaking information about the installation of Oracle Enterprise Performance Management System products is provided in the Oracle Enterprise Performance Management System Installation and Configuration Readme. Review this information thoroughly before installing EPM System products.

Installation Guidelines

The guidelines in this section should be considered when you install the Oracle Smart View for Office client.

Installer Language

The installer is automatically displayed in the language set in the Format field of the Windows Region and Language dialog box in the Control Panel.

However, some messages, both on-screen and in the log file, cannot be translated and will appear in English.

For more information about language settings, see Windows, Office, and Smart View Locale Settings.

Installation and Windows Access Control Settings

Starting with the 11.1.2.5.400 release, you can install Oracle Smart View for Office as a System user or as a non-admin user.

Windows User Access Control (UAC) settings can affect Smart View installation. For information on setting UAC, see the Microsoft Windows documentation.

Also, see the Oracle Smart View for Office Readme, "Known Issues," "Installation" topic, for any installation issues.

<table>
<thead>
<tr>
<th>Table 2-1 Installation Guidelines for System, Admin, and Non-Admin Users</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Context</strong></td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>System user</td>
</tr>
</tbody>
</table>
Table 2-1  (Cont.) Installation Guidelines for System, Admin, and Non-Admin Users

<table>
<thead>
<tr>
<th>Installation Context</th>
<th>Scenario</th>
<th>UAC-Enabled</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator</td>
<td>The user runs SmartView.exe with the &quot;Run as Administrator&quot; command or from an elevated command prompt</td>
<td>Depending on the UAC level, the user may need to go through the UAC UI sequence</td>
<td>Smart View is installed on the machine level</td>
</tr>
<tr>
<td>Non-admin user</td>
<td>The user installing Smart View may or may not be a member of the Administrators group.</td>
<td>No UAC interaction is expected.</td>
<td>Smart View is installed on the current user's level; other users will not be able to run Smart View</td>
</tr>
</tbody>
</table>

Note:
Not supported on Windows 8.x, Windows 10, or Windows server platforms.

Notes:
- This scenario is not supported: A user installs Smart View, and then, on the same machine, another user tries to install Smart View in the same location as the previous installation.
- After non-admin installations, launching Office applications with Smart View content from Internet Explorer will fail in protected mode.
- Upgrade in mixed installation context is not supported. For example, upgrading the previously-installed per-machine installation with a per-user one is not supported (Error 1925).
- Silent installations are not supported for non-admin users. When attempting a silent installation, the /s flag is ignored for non-admin users, causing the Smart View product installer to launch.
- Non-admin users are not authorized to install Smart View in the C:\Program Files or C:\Program Files (x86) folders.

Microsoft .NET Framework Support

To install and use Oracle Smart View for Office release 11.1.2.5.600+, Microsoft .NET Framework 4.5 or higher is required.

BiDi Support in Installer

The Oracle Smart View for Office installer does not fully support bidirectional (BiDi) languages. This can result in installer screens containing formatting errors such as misaligned text and icons. The installer can be used, however, and the installed Smart View product will display correctly in BiDi languages.
Planning Offline Support

Although Planning Offline is supported for 64-bit operating systems, it is not supported for 64-bit Oracle Smart View for Office installations. If you use Planning Offline with Smart View, you must install the 32-bit version of Microsoft Office.

Note:
Planning Offline is support with Oracle Hyperion Planning on-premises only. Planning Offline is not supported with Oracle Planning and Budgeting Cloud.

Installing from My Oracle Support or Oracle Technology Network

To install Oracle Smart View for Office directly from My Oracle Support (MOS) or Oracle Technology Network (OTN):

1. Before you begin:
   - If you are upgrading to this release from an earlier Smart View release, Oracle recommends that you first uninstall the earlier release before installing this release.
   - Ensure that Microsoft .NET Framework 4.5 or higher is installed on the computer where you are installing Smart View.

2. Close all Microsoft Office applications.

3. Download the Smart View zip file from either MOS or OTN:
   - From MOS:
     https://support.oracle.com/oip/faces/secure/km/DocumentDisplay.jspx?id=1923582.1
     This Knowledge Article provides a link to the current version of Smart View.
   - From OTN:
     Before downloading, review the "OTN License Agreement" accessed from the Smart View download page to ensure that your usage is compliant.

4. Unzip the file to a temporary location.

5. Double-click SmartView.exe to start the installation wizard.

6. Select a destination folder for Smart View, and then click OK.
   For new installations, Smart View is installed by default in:
   C:\Oracle\SmartView
If you are upgrading an existing installation of Smart View, the installer defaults to the folder where Smart View was previously installed.

7. When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint, or Word.

**Installing by Autodeployment in EPM System**

These instructions are for upgrading from Oracle Smart View for Office 11.1.2.1.x and later only. If you are upgrading from Smart View 11.1.2.0.x or earlier, use the autodeployment instructions provided in the documentation for the specific release.

**Server Setup**

To set up the server environment for autodeployment of Oracle Smart View for Office:

1. Enable autodeployment for your data provider as follows.
   
   - **Oracle Essbase:** Choose a method:
     
     a. Use Administration Services Console (if available).
        
        a. Connect to the Provider Server, select Edit, then Properties, then Client Deployment.
     
     b. Choose either Force Smart View client to upgrade or Warn Smart View client to upgrade.
     
     c. Select the Apply Smart View client to upgrade check box, and then click Apply.
     
     - Update essbase.properties as follows:
       
       a. Navigate to EPM_ORACLE_INSTANCE\bin\essbase.properties.
       
       b. Set either or both of these properties to true:

       ```
       smartview.webservice.autodeploy.force=true
       smartview.webservice.autodeploy.warn=true
       ```
   
   - **Oracle Hyperion Planning:**
     
     a. Select Administration, then Manage Properties, and then System Properties.
     
     b. Set these properties:

     ```
     SMART_VIEW_FORCE_INSTALL=true
     SMART_VIEW_DISPLAY_WARNING=true
     ```
   
   - **Oracle Hyperion Financial Management:** In the Financial Management Web Server Configuration Utility for Smart View, select Always force client to upgrade.
   
   - **Oracle Hyperion Reporting and Analysis:** Autodeployment is automatic.

2. Make backup copies of your current SmartView.exe and version.xml before deploying the replacement files.
3. Download the Smart View zip file from either OTN or MOS, as described in Installing from My Oracle Support or Oracle Technology Network.

4. Unzip the downloaded file to a temporary location.

5. Copy SmartView.exe and version.xml to the location of the Oracle Hyperion Enterprise Performance Management Workspace installation, typically:  
   `C:\Oracle\Middleware\EPMSytem11R1\common\epmstatic\wspace\SmartView`

   This is the epmstatic location specific to Smart View.

6. Depending on which version of Smart View your users are upgrading from, perform either Option A OR Option B.

   • Option A (Upgrading from 11.1.2.1.x, 11.1.2.2.x, or 11.1.2.3.x)
     If your users are upgrading from an installed Smart View version of 11.1.2.1.x, 11.1.2.2.x, or 11.1.2.3.x, open the version.xml file in the epmstatic location specific to Smart View (see step 5), and edit the value in the installFile tag to point to the location of the Smart View executable file (step 5) as follows:
     ```xml
     <installFile>
     /epmstatic/wspace/SmartView/SmartView.exe
     </installFile>
     ```

   • Option B (Upgrading from 11.1.2.5.000 or Later)
     If your users are upgrading from an installed Smart View version 11.1.2.5.000 or later, choose only one of the following options and perform the tasks described:
   
   – OTN Option
     Do not modify the version.xml file in the epmstatic location specific to Smart View (step 5).
     Your users will automatically be directed to the Smart View page on OTN, where they can download the installation zip file to their own machines, unzip the contents, and run the installer.

   – "epmstatic" Option
     Open the version.xml file in the epmstatic location specific to Smart View (see step 5) and edit the value in the installFile tag to point to the location of the Smart View executable file (step 5) as follows:
     ```xml
     <installFile>
     /epmstatic/wspace/SmartView/SmartView.exe
     </installFile>
     ```

   – Web App Server Option
     Post the SmartView.exe file to a web app server in your environment, and then modify the version.xml file to point to the fully-qualified URL.
     
     a. Copy only the SmartView.exe to the web app server where you will be hosting the file.
     
     b. Open the version.xml file in the epmstatic location specific to Smart View (see step 5), and edit the value in the installFile tag to point to the fully-qualified URL where you are hosting the Smart View executable file (see step a); for example:
Client Installation

In the previous section, Server Setup, if you chose the OTN Option in Option B, then your users will be directed to OTN for the Oracle Smart View for Office download. In that case, your users should follow the instructions for OTN download and installation in Installing from My Oracle Support or Oracle Technology Network.

If you did not choose the epmstatic Option or Web App Server Option in Option B, then complete the following procedure.

To install the Smart View client:

1. In Smart View, select Panel.

2. Connect to a data source in one of the following ways:
   - Through a shared connection
   - Through a private connection with the following URL:
     - Oracle Essbase: http://<server>:19000/aps/SmartView
     - Oracle Hyperion Planning: http://<server>:19000/Planning/SmartView
     - Oracle Hyperion Reporting and Analysis: http://<server>:19000/raframework/browse/listxml

   **Note:**
   If you are using Reporting and Analysis release 11.1.2.1.000 or earlier, Smart View autodeployment will not work (10233672, 12870087).

3. When the message “New Smart View client version available” is displayed, select Click here to Install.

4. In the Internet Explorer browser that launches, in File Download, select Run.

   **Note:**
   Internet Explorer will launch even if Firefox is your default browser.

5. If a Microsoft Excel security warning is displayed, select Run.

6. When prompted, confirm the upgrade; click Yes.

7. The installation wizard is displayed; click OK.
The installer is automatically displayed in the language set in the Format field of the Windows Region and Language dialog box in the Control Panel.

8. If prompted, close all open Microsoft Office applications, and then click OK.

9. In the installation wizard, click OK and follow the prompts to install Smart View.

10. When installation is complete, click OK.

   The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint, or Word.

11. Open Excel.

12. On the Smart View ribbon, select the arrow next to Help, and then select About.

13. Verify the new version of Smart View.

### Installing from EPM Workspace

**Related Topics:**

- Workspace Setup
- Client Installation

### Workspace Setup

To set up the Workspace environment for the updated Oracle Smart View for Office installer:

1. Make backup copies of your current SmartView.exe and version.xml before deploying the replacement files.

2. Download the Smart View zip file from either OTN or MOS, as described in Installing from My Oracle Support or Oracle Technology Network.

3. Unzip the downloaded file to a temporary location.

4. Copy SmartView.exe and version.xml to the location of the Oracle Hyperion Enterprise Performance Management Workspace installation, typically:

   ```
   C:\Oracle\Middleware\EPMSystml1R1\common\epmstatic\wspace\SmartView
   ```

### Client Installation

To install Oracle Smart View for Office from Oracle Hyperion Enterprise Performance Management Workspace:

1. In EPM Workspace, select Tools, then Install, and then Smart View.

2. In File Download, select Run.

3. If a Microsoft Excel security warning is displayed, select Run.

4. Select a destination folder for Smart View, and then click OK.

   For new installations, Smart View is installed by default in:

   ```
   C:\Oracle\SmartView
   ```
If you are upgrading an existing installation of Smart View, the installer defaults to the folder where Smart View was previously installed.

5. When installation is complete, click OK.

The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint, or Word.

**Installing from Oracle BI EE**

Related Topics:

- Configuring the Oracle BI EE Analytics Home Page
- Installing from the Oracle BI EE Analytics Home Page

**Configuring the Oracle BI EE Analytics Home Page**

Note:

Configuring a custom download link for the Smart View installer applies to Oracle Business Intelligence Enterprise Edition 11.1.1.7.1 and later versions, and might not be available in earlier versions.

Starting in Oracle BI EE release 11.1.1.9, the **Smart View for MS Office** link on the **Download BI Desktop Tools** drop-down list points to the Oracle Smart View for Office download on Oracle Technology Network.

If you do not want to direct your users to Oracle Technology Network, you can configure the **Smart View for MS Office** link to point to a custom download link for the Smart View installer. You can then ensure that the correct version of Smart View for your environment is always available to your users. Do this by adding the **SmartViewInstallerURL** element to **instanceconfig.xml**.

You can configure the download link point to a location where the **smartview.exe** resides; for example:

- An external URL
- An internal URL, such as internal web page or intranet location where the installation can start immediately
- A folder on a local server where the installation can start immediately

To configure a custom download link for the Smart View installer:

1. Open the **instanceconfig.xml** file for editing

   Refer to "Where Are Configuration Files Located?" in the **Oracle Fusion Middleware System Administrator’s Guide for Oracle Business Intelligence Enterprise Edition**.

2. Locate the **CatalogPath** and **<DSN>AnalyticsWeb</DSN>** sections and add the **SmartViewInstallerURL** element after those sections.

3. Use the syntax in the following examples to add the **SmartViewInstallerURL** element.
Example for download from Oracle Technology Network:

<CatalogPath>/example/path/work/abc/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleApp</CatalogPath>
<DSN>AnalyticsWeb</DSN>
<SmartViewInstallerURL>http://www.oracle.com/technetwork/middleware/epm/downloads/
smart-view-1112x-1939038.html</SmartViewInstallerURL>

Example for download from an intranet site:

<CatalogPath>/example/path/work/abc/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleApp</CatalogPath>
<DSN>AnalyticsWeb</DSN> <SmartViewInstallerURL>http://myserver:8080/downloads/
smartview.exe</SmartViewInstallerURL>

Example for download from an internal server:

<CatalogPath>/example/path/work/abc/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleApp</CatalogPath>
<DSN>AnalyticsWeb</DSN> <SmartViewInstallerURL>\myserver\downloads\smartview.exe</SmartViewInstallerURL>

4. Save your changes and close the file.
5. Restart the Oracle BI EE instance.

Installing from the Oracle BI EE Analytics Home Page

To install Oracle Smart View for Office from Oracle Business Intelligence Enterprise Edition Home:

1. In Oracle BI EE Analytics Home page, click the arrow next to Download BI Desktop Tools, and then select Smart View for MS Office.
   
   If you are directed to the Smart View download page on Oracle Technology Network, then follow the procedure in Installing from My Oracle Support or Oracle Technology Network. Otherwise, proceed with step 2.

2. Choose an option:
   
   • Click Run to run the installer directly.
     
     If the User Account Control dialog box is displayed, click Yes, and then continue to step 3.
   
   • Click Save to save the Smart View installer file to a directory to which you have access and from which you can run executable files.
     
     Open the folder where you saved the Smart View executable and double-click it to run it. Then continue to step 3.

3. Select the language to use for the installation wizard.
4. Click Next.
5. Follow the prompts in the wizard.
6. When installation is complete, click Finish.
The Smart View ribbon is displayed the next time you open Microsoft Excel, PowerPoint, or Word.

**Running Command Line or Silent Installations**

In addition to command line installations, administrators can enable silent installations—installations that do not require settings to be specified each time—for Oracle Smart View for Office. The silent installation command can be included in scripts to automate installation.

**Note:**
Silent installations are not supported for non-admin users.

The silent installer wrapper follows these rules:

- It passes the value of the /v parameter intact to the MSI.
- The /s flag is converted to /qn and passed to the MSI. There is no need to specify the /qn parameter if /s is already present in your script.
- Unless the /v parameter contains any /q specifier, the wrapper passes /qb+ to the MSI.

<table>
<thead>
<tr>
<th>Option</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>/v&quot;command line options&quot;</td>
<td>Specifies command line options to be passed to the client installer.</td>
</tr>
<tr>
<td>/s</td>
<td>Runs the client installer as a silent installer.</td>
</tr>
<tr>
<td>INSTALLDIR=</td>
<td>Specifies the installation directory.</td>
</tr>
<tr>
<td>l*v log file path and name</td>
<td>Logs installation information in the specified file.</td>
</tr>
<tr>
<td>/extensionupdateList=</td>
<td>Path to UpdateList.xml</td>
</tr>
</tbody>
</table>

Before you begin, follow the procedure in Installing from My Oracle Support or Oracle Technology Network to download the Smart View installation zip file and unzip it to the folder you will be working in.

To run silent installations:

1. Open a command prompt.
2. Navigate to the directory of the Smart View installer.
3. Run the installation commands; for example:
   - To install in the default directory, run:
     ```bash
     SmartView.exe /s
     ```
   - To install in another directory, run:
     ```bash
     SmartView.exe /s /v"INSTALLDIR=<target path>"
     ```
For example:

```
SmartView.exe /s /v" INSTALLDIR=D:\SmartView"
```

- To specify the location of UpdateList.xml, run:

```
SmartView.exe /s /extensionupdatepath=<path to UpdateList.xml>
```

- To run a silent installation and log the installation sequence:

```
SmartView.exe/s/v" INSTALLDIR=D:\SmartView /L*v c:\install.log"
```

**Downloading Help for Local or Web Server Installation**

After installing Oracle Smart View for Office, the online help is retrieved from a URL hosted on the Oracle.com web site. This is the default behavior for Smart View, and no changes are required by users to launch help.

However, you may require that the help be installed locally or on a web server in your organization. Some examples for the need to access help from a location other than Oracle.com are:

- Help files must be installed on a local drive on an individual’s computer for Section 508 accessibility purposes.
- Internet access limitations; for example, your users only have access to URLs on your organization’s intranet.

To accommodate the above types of cases, a downloadable help zip file is posted on My Oracle Support as a patch to the current Smart View release.

The procedure below describes downloading the help zip file. Further instructions for installation and configuration are in the following guides:

- **Installing and Configuring Help Locally or on a Web Server** in this guide.
- **Oracle Smart View for Office Accessibility Guide**. See “Installing and Configuring Help Locally.”

To download the Smart View help zip file from My Oracle Support (MOS):

1. Log in to MOS.
2. Select the **Patches & Updates** tab.

   The **Patch Search** area is displayed at the right of the screen with the **Search** tab selected by default.

3. Under the **Number/Name or Bug Number (Simple)** heading, ensure that **Patch Name or Number** is selected in the drop-down list box.
4. In the **Patch Search** text box, type this Smart View patch number:

   23206405

   The **Patch Search** text box is to the right of the **Patch Name or Number** drop-down list box.
5. Click **Search**.
6. Download the patch zip file to a temporary directory.
7. To install and configure the help according to your requirements, follow the instructions in either of the following guides:
   - Installing and Configuring Help Locally or on a Web Server in this guide.
   - Oracle Smart View for Office Accessibility Guide. See "Installing and Configuring Help Locally."

Uninstalling Smart View

This topic describes uninstalling Oracle Smart View for Office.

To uninstall extensions, see "Uninstalling Extensions" in the Oracle Smart View for Office User’s Guide.

To uninstall Smart View:

1. Before you begin, close all Office applications.
2. Go to your Windows system Control Panel and navigate to Uninstall or change a program.
3. Locate and select the version of Smart View that applies to your installation:
   - Oracle Smart View 32-bit for Office
   - Oracle Smart View 64-bit for Office
4. Click Uninstall.
Administering Extension Installations and Updates

The extension installation and update process described in this topic enables Oracle Smart View for Office end users to install, update, or uninstall extensions based on parameters set by the Smart View administrator in the manifest file, UpdateList.xml.

About Extension Installations and Updates

Auto-Update versus Manual Update

In releases earlier than Oracle Smart View for Office 11.1.2.5.400, extensions were updated using the Auto-Update process. To update extensions with Auto-Update, Smart View end users could go to the Extensions tab of the Options dialog box and click the Check for updates link or select the Check for updates when Microsoft Office starts check box to initiate extension updates. For all extensions, if any updates were available, they were retrieved and installations were automatically initiated.

In release 11.1.2.5.400 and later, you can customize the extension update process so that Smart View end users can control when they install, update, and remove extensions. The Smart View administrator configures attributes in the UpdateList.xml manifest file to control the options available to the users. If the administrator does not configure these attributes in UpdateList.xml, extensions will continue to be updated using the existing Auto-Update process.

Types of Extensions

There are two types of extensions that can be installed on a Smart View client machine:

- **Provider extensions.** Extensions that are dependent on, or integrated with, Oracle components are provider extensions. Examples are the Oracle Hyperion Disclosure Management and Oracle Hyperion Financial Reporting extensions. Provider extensions can be configured as required extensions.

- **Per-user extensions.** Extensions that are installed in the user’s application data folder. These extensions may or may not be dependent on Oracle components. Additionally, per-user extensions can also be configured as required extensions.

The Smart View administrator configures the UpdateList.xml file to specify the list of provider and per-user extensions available to end users along with options for installing, updating, and removing them. Additionally, per-user extensions can also be configured to display an indicator for required extensions and does not force the installation. The Smart View end user then accesses the Options dialog box and installs, updates, or uninstalls the extensions that are available to him or her in the Extensions tab.

To configure provider and per-user extension installation, uninstallation, and updating, complete the procedure in Configuring Manual Extension Updates.
If you do not want to make changes to the extension update process, you may refer to Configuring Auto-Update Extensions for information on the structure of the XML and examples, but you do not need to take any further action.

For instructions on installing, updating, and removing extensions in Smart View, end users can refer to the procedure topics in "Extensions" in the "Smart View Options" chapter in the Oracle Smart View for Office User’s Guide.

About the Oracle Journals for Financial Management Extension

The Oracle Journals extension is unique among Smart View extensions in that the extension installer file is included in the extensions folder of the Smart View installation. End users can install the Oracle Journals extension directly from the extensions folder of their Smart View installation.

Or, as administrator, you can control how your Smart View end users install the Oracle Journals extension, automatically or manually, via the Extensions page of the Smart View Options dialog box.

If you choose to set up automatic or manual installations of the Oracle Journals extension, you should install Smart View in a test environment first, then refer to the UpdateList.xml file, found in the extensions folder of your Smart View installation. Use the entry in this file as a guideline for the Oracle Journals entry you will add to the UpdateList.xml file, as described in Configuring Manual Extension Updates.

Configuring Manual Extension Updates

Auto-Update extensions in the UpdateList.xml manifest file can be configured so that the Oracle Smart View for Office end user can see the available extensions, including per-user extensions, and install them from the Extensions tab of the Options dialog box.

You can add two attributes, visible and allowUninstall, to the UpdateList.xml manifest file to change the behavior of the extensions from auto-update to manual update so that the extensions are displayed in the Options dialog box:

- **visible**—A value of "1" indicates that the extension will appear in the Extensions tab of the Smart View Options dialog and will NOT be part of the Auto-Update process.

  If the visible attribute is missing or the value is not "1", the extension is included in the Auto-Update process.

- **allowUninstall**—A value of "1" indicates that the user can initiate an uninstall through the Extensions tab of the Options dialog box using the Remove link.

  If the allowUninstall attribute is missing or the value is not "1", the user may not initiate an uninstall in the Extensions interface (the Remove link will not be there).

This procedure is optional. If you choose not to add the attributes to UpdateList.xml, extensions will continue to be updated as they were in releases earlier than 11.1.2.5.400. In pre-11.1.2.5.400 releases, users click the Check for updates link or select the Check for updates when Microsoft Office starts check box to initiate extension updates.

To add attributes to the `UpdateList.xml` manifest file for extensions:

1. Open the `UpdateList.xml` file for editing.

   The manifest file is found in two locations:
   - `epmstatic`:
     http://server:port/epmstatic/smartview/Client/UpdateList.xml
   - The location pointed to by the `<extensionupdatelist>` tag in `C:\Oracle\SmartView\cfg\properties.xml`.

   To populate the `<extensionupdatelist>` tag, you can either perform a command line installation, as described in Running Command Line or Silent Installations, or manually update the tag in the `properties.xml` file.

   **Note:**
   In `properties.xml`, if multiple URLs exist for an extension installer, Smart View checks all locations and installs from the location containing the latest version.
   If multiple URLs exist for the same version of an extension installer, Smart View installs from the first URL in the list.

2. **Optional:** To display an extension in the **Extensions** tab of the **Options** dialog box, and exclude the extension from the Auto-Update process, add the `visible="1"` attribute to the XML for the extension; for example:

   ```xml
   <update>
   version="11.1.2.3.500.021"
   location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
   visible="1"
   allowUninstall="1">Oracle Disclosure Management
   </extension>
   
   Figure 1 shows an example of an extension displayed in the Extensions tab.
   
   **Figure 3-1   Extension as Displayed in the Extensions Tab**

```

3. **Optional:** To display the **Remove** button, ✖️ Remove, for an extension, add the `allowUninstall="1"` attribute to the XML for the extension; for example:

   ```xml
   <update>
   version="11.1.2.3.500.021"
   extension id="A.Unique.Id.That.Matches.Extension.Descriptor.Id"
   location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
   visible="1"
   allowUninstall="1">Oracle Disclosure Management
   </extension>
   
   Figure 2 shows an example of an extension displayed in the Extensions tab.
4. For each provider and per-user extension, repeat step 2 and step 3 according to your requirements.

5. **Optional:** To remove a single extension from the list of extensions available for Auto-Update in the `UpdateList.xml` file, use the alternative method of commenting out the extension with the `<!--` and `-->` characters; for example:

   ```xml
   <!--
   <extension>
   location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
   version="11.1.2.4.078" id="nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn"> Oracle
   Disclosure Management
   </extension>
   -->
   
   You can also comment out the entire list of extensions if your goal is to exclude all extensions from the manual update process.

**Manual Update XML Defined**

- `<update>`
  The root node. This is a tag.

- `<extension>`
  Parent node for `extension` attributes. This is a tag.

Attributes of `<extension>` are:

- `id`
  The extension identifier. The identifier must match the `SVExtensionDescriptor.GUID` defined in the extension. It does not need to be a GUID, it only needs to be unique. This name will appear in the Windows Registry. For this reason, Oracle recommends using readable identifiers; for example, Oracle.Disclosure.Management.

- `format`
  A value of "1" indicates that the entry for the extension uses the manual update XML format introduced in Oracle Smart View for Office 11.1.2.5.400. This XML format supports more user interface features than the standard Auto-Update format.

- `version`
  The version number of the extension. The version number must match exactly with the extension descriptor version in the extension assembly.

- `svVersion`
  The Smart View version that the extension works with.

- `visible`
Set this value to "1" to display the extension in the **Extensions** tab of the **Options** dialog box. When this is set to "1", the extension will NOT be part of the Auto-Update process.

- **manualUpdate**
  Set this value to "1" if the user needs to close Excel for installation update. The update installer file will be downloaded and a message will be displayed indicating the required restart of Office. Also, the download folder will be opened.

- **manualInstall**
  Set this value to "1" if the user needs to close Excel for installation. The installer file will be downloaded and a message will be displayed indicating the required restart of Office. The download folder will be opened.

- **allowUninstall**
  Set this value to "1" to display the **Remove** button in the **Extensions** tab of the **Options** dialog box.

- **type**
  The type of extension. Valid values are:
  - 0 = optional extension
  - 1 = provider extension
  - 2 = Smart View client

- **required**
  Set to display a "Required" or "Recommended" icon for the extension. No action is done other than the visible icon.

- **<name>**
  The name of the extension. This is a tag.

- **<desc>**
  The extension description. This is a tag.
  Uses the "default" attribute. The default description for the extension will be the description displayed in the **Extensions** tab.

- **owner**
  The creator or owner of the extension; for example, Oracle.

- **location**
  The location and file name of the extension installer file. This can be msi or svext; exe is not supported.

- **<uninstallMsg>**
  Optional. For uninstalls, displays a custom message to the user.
  Uses the "default" attribute. The default description for the uninstallMsg will be the custom message displayed during uninstall.
Configuring Auto-Update Extensions

You can add the visible and allowUninstall attributes to the UpdateList.xml manifest file to change the behavior of the extensions that are part of the Auto-Update process.

If you do not add the attributes to UpdateList.xml, extensions will continue to be updated using the existing Auto-Update process.

To add the visible and allowUninstall attributes to the Auto-Update extensions, complete the procedure in Configuring Manual Extension Updates.

See Auto-Update XML Defined and Auto-Update XML Example for reference.

You can also remove an single extension from the list of extensions available for Auto-Update in the UpdateList.xml file by commenting out the extension using the <!-- and --> characters. For example:

```xml
<!--
<extension>
location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi" version="11.1.2.4.078"
id="nnnnnnnn-nnnn-nnnn-nnnn-nnnnnnnnnnnn" Oracle Disclosure Management
</extension>
-->
```

If you comment out the entire list of extensions, then all extensions are excluded from the manual update process.

Auto-Update XML Defined

- `<update>`
  
  The root node. This is a tag.
• <extension>

Text that contains the extension name. This is a tag. The extension name appears in
the Extensions tab of the Options dialog box. Examples of extension names are
Oracle Predictive Planning Extension, Disclosure Management, or Adjust Data.

Attributes of <extension> are:

– id

The extension identifier. The identifier must match the
SVExtensionDescriptor.GUID defined in the extension. It does not need to be a
GUID, it only needs to be unique. This name will appear in the Windows
Registry. For this reason, Oracle recommends using readable identifiers; for
example, Oracle.Disclosure.Management.

– version

The version number of the extension.

– location

The location and file name of the extension installer file. This can be msi or
svext; exe is not supported.

– operation

Optional. For Auto-Updates, set this value to “delete” to have the uninstall
automatically begin when the user opens Office.

Note:

The first time a user opens Office, if Oracle Smart View for Office determines
that the extension needs to be uninstalled, the subsequent opening of Office
initiates the uninstall process.

– options

Optional. For msi installations only. All options for the Microsoft Windows
Installer Tool, Msiexec.exe, are supported.

– visible

Set this value to "1" to display the extension in the Extensions tab of the
Options dialog box. When this is set to "1", the extension will NOT be part of
the Auto-Update process.

– allowUninstall

Set this value to "1" to display the Remove button in the Extensions tab of the
Options dialog box.

Auto-Update XML Example

```
<update>
  <extension id="A.Unique.Id.That.Matches.Extension.Descriptor.Id"
    version="11.1.2.3.500.021"
    location="/epmstatic/disclosure_mgmt/svext/DiscManSetup.msi"
    visible="1"
    allowUninstall="1">Disclosure Management
```
<extension id="Another.Unique.Id"
    version="11.1.2.3.300"
    location="/epmstatic/SomeSetup.msi"
    operation="delete">Crystal Ball EPM
</extension>

<extension id="And.Another.Unique.Id"
    version="11.1.2.3.300"
    location="/epmstatic/SomeSetup.msi"
    options="/promptrestart">Oracle Predictive Planning"
</extension>
</update>
Accessing Shared Connections from an XML File

Related Topics:

About Accessing Shared Connections from an XML File
Setting Up the Shared Connections XML File
Connection File Syntax and Example

About Accessing Shared Connections from an XML File

Note:
The procedures in this chapter apply to shared connections only.

You can use shared connection information from an XML file to connect to supported Oracle Smart View for Office providers, both cloud and on-premises. The XML file can exist either locally on each individual Smart View client machine or on a web server. Smart View end users point to this XML file in the Shared Connections URL field of the Options dialog box, and then access the available providers as they would any other shared connection to which they have access.

To connect to an Oracle Business Intelligence Enterprise Edition provider from the Shared Connections Panel in Smart View, you must follow the procedures in this topic. However, you may also connect to Oracle BI EE data sources from the Private Connections Panel using the procedure described in "Creating Private Connections" in the Oracle Smart View for Office User’s Guide.

Note:
Only ASCII characters are supported in the XML file. Do not use non-ASCII characters in any of the entries you make in this file.

Caution:
The procedures in this chapter should be completed by the Smart View administrator.
Setting Up the Shared Connections XML File

Setting up the shared connections XML file involves preparing the XML file and distributing it to your users.

To set up shared connections in an XML file:

1. Create an empty XML file using any text editor and save it on your Oracle Smart View for Office client machine.

   Give the file a meaningful name, such as SmartViewProviders.xml, and ensure that it has the .xml extension.

   **Note:**
   Only ASCII characters are supported in the XML file. Do not use non-ASCII characters in any of the entries you make in this file.

2. Add the following line to the beginning of the file:

   ```xml
   <?xml version="1.0" encoding="UTF-8"?>
   ```

3. Next, add the opening res_GetProvisionedDataSources tag:

   ```xml
   <res_GetProvisionedDataSources>
   ```

4. Add entries for the applicable providers.

   You can add entries for Oracle Hyperion Provider Services (Oracle Essbase), Oracle Hyperion Planning (both on-premises and in Oracle Planning and Budgeting Cloud), Oracle Hyperion Financial Management, Oracle Hyperion Reporting and Analysis, Oracle Hyperion Strategic Finance, Oracle Business Intelligence Enterprise Edition, and Oracle Enterprise Performance Reporting Cloud. The XML can contain entries for supported cloud providers, on-premises providers, or a mix of both.

   When you create your entries, copy the syntax exactly and make ONLY these substitutions:

   - In the **Product** tag, **displayVersion** attribute:
     `version`—The version number of the specified provider.

   - In the **Server** tag, **context** attribute:
     `webServerHost`—The web server host machine name.
     `webServerPort`—The web server port number. Use the default port number that is already noted in the syntax for each provider. Or, if you have configured your system using non-default port numbers, provide them.

   The syntax for each provider type is below.

   **Provider Services (Essbase)**

   ```xml
   <Product id="APS" name="APS-11.1.2" displayVersion="version">
   <Server name="Oracle Hyperion Provider Services" context="http://webServerHost:webServerPort/aps/SmartView"/>
   </Server>
   ```
Planning or Oracle Planning and Budgeting Cloud

<Product id="HP" name="HP-11.1.2" displayVersion="version">
</Product>

Financial Management

<Product id="HFM" name="HFM-11.1.2" displayVersion="version">
</Product>

Reporting and Analysis

<Product id="RAFramework" name="RAFramework-11.1.2" displayVersion="version">
  <Server name="Reporting and Analysis Framework" context="http://webServerHost:webServerPort/raframework/browse/listXML"></Server>
</Product>

Strategic Finance

<Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2" displayVersion="version">
  <Server name="Oracle Hyperion Strategic Planning, Fusion Edition" context="webServerHost:webServerPort/StrategicPlanning/SmartView"></Server>
</Product>

Oracle BI EE

<Product providerType="ExtensionProvider" id="27EE9B0D-D5F5-42c9-AFC5-44FEA70C693" name="OBI EE-11.1.1.7" displayVersion="version">
</Product>

Enterprise Performance Reporting Cloud Service

<Product id="EPRCS" name="Enterprise Performance Reporting Cloud Service" displayVersion="version">
  <Server name="EPRCS" context="http://webServerHost:webServerPort.epam/SmartView"></Server>
</Product>

5. Optional: If you are planning to access help locally or from an internal URL, add an entry for locating the help:

- Help installed on a local drive:
  
  <helpurlcontext>file:///parent_language_folder_path/</helpurlcontext>

  For example:
  
  <helpurlcontext>file:///C:/Oracle/SmartView/smartview_help/</helpurlcontext>

- Help installed on a web server:

  <helpurlcontext>http://webServerHost:webServerPort/PathToHelpFiles/smartview_help/</helpurlcontext>

  For example:
<helpuricontext>http://abcxyzco.com:12345/user_documentation/smartview_help/</helpuricontext>

Notes:

- Perform this step ONLY if you are planning to access shared connections from an XML file AND are required to access help either from a local drive or a web server within your organization. See Installing and Configuring Help Locally or on a Web Server for instructions on setting up help.

- If you use the <helpuricontext> tag, the help location you specify overrides the default or modified location specified in the <helpuricontext> tag in the properties.xml file, as described in Optional Local Help Configuration via the Shared Connections XML File.

6. Optional: Add an entry for the User Productivity Kit (UPK):

   <UPK>http://link to User Productivity Kit</UPK>

   For example:

   <UPK>http://download.abcxyzco.com/ocomdocs/PlayerPackage/data/toc.html</UPK>

7. Add the closing res_GetProvisionedDataSources tag to complete the file, then save it.

   </res_GetProvisionedDataSources>

   See Connection File Syntax and Example for the full syntax and an example of how this file should be set up.

8. Test the file:

   a. Perform an action:

      • If you plan to have users copy the XML file to their local drive, ensure that the file is copied to a local drive on your Smart View client machine.

         For example, the file may be copied to the SmartView\bin directory.

      • Alternatively, if you plan to copy the file to a web server, ensure that the file is accessible to your users from a fully-qualified URL that includes the XML file name and the .xml extension.

   b. Start Smart View and in the Options dialog box, edit the Shared Connections URL to add the full path to the file or a URL, ensuring that the .xml file name extension is included.

   Note:

   This feature will not work if the .xml file name extension in not included at the end of the local drive path or URL.

   • Local drive example:

     C:/Oracle/SmartView/bin/SmartViewProviders.xml

     Ensure that you use forward slashes (/) as separators in the file path.
The directory path and file should now be available in the list of shared connections.

- Web server URL syntax:
  http://webServerHost:webServerPort/pathToFile/filename.xml

  Web server URL example:
  http://abcxyzcowebserver:1234/SmartViewDataSources/SmartViewProviders.xml

  The URL should now be available in the list of shared connections.

  **c.** Connect to the file using the **Shared Connections** option in the Smart View Panel, as described in "Connecting to Data Sources" in the *Oracle Smart View for Office User’s Guide.*

  If you do not see provider entries listed in the **Shared Connections** drop-down list, then the XML file may contain incorrect syntax or invalid characters.

  **Tip:**
  Verify the XML by opening the file in a browser; for example, in Internet Explorer. The browser will specify the invalid syntax. Correct any errors in the XML file editor, save, and refresh the browser display.

  **9.** When the XML file is correct and complete, perform one of the following procedures:

  - If you plan to have users copy the XML file to their local drive, distribute the file to your Smart View users with these instructions:
    
    **a.** Do not modify this file in any way.
    
    **b.** Copy the file to a local drive on your Smart View client machine.
      
      For example, the file may be copied to the `SmartView\bin` folder.
    
    **c.** Start Smart View and in the **Options** dialog box, edit the **Shared Connections URL** with the full path to the file on the local drive, including the file name and `.xml` extension; for example:
    
    `C:/Oracle/SmartView/bin/SmartViewProviders.xml`

      Ensure that you use forward slashes (`/`) as separators in the file path.

      The directory path and file is now available in the list of shared connections.
    
    **d.** Test by connecting to the file using the Shared Connections option in the Smart View Panel, as described in "Connecting to Data Sources" in the *Oracle Smart View for Office User’s Guide.*

      If you have problems connecting, contact your Smart View administrator.
  
  - If you plan to copy the XML file to a web server, notify your Smart View users with these instructions:
    
    **a.** Start Smart View and in the **Options** dialog box, edit the **Shared Connections URL** with the URL provided, including the file name and `.xml` extension; for example:
http://abcxyzcowebserver:1234/SmartViewDataSources/SmartViewProviders.xml

b. Test by connecting to this URL using the Shared Connections option in the Smart View Panel, as described in "Connecting to Data Sources" in the *Oracle Smart View for Office User’s Guide*.

If you have problems connecting, contact your Smart View administrator.

c. **Internet Explorer users:** To use the URL given in step a, Oracle recommends setting the following options in Internet Explorer:

i. Select **Tools**, then **Internet Options**.

ii. In the **General** tab, **Browsing history** group, select **Settings**.

iii. In the **Check for newer versions of stored pages** section, select **Every time I visit the webpage**, and then click **OK**.

iv. In the **Internet Options** dialog box, select the **Advanced** tab.

v. In the **Security** section, select the **Empty Temporary Internet Files folder when browser is closed** option.

vi. Click **OK** to close **Internet Options** and restart the browser.

**Connection File Syntax and Example**

**Related Topics:**

- [Connection File Syntax](#)
- [Connection File Example](#)

**Connection File Syntax**

Below is the file syntax in its entirety:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<res_GetProvisionedDataSources>
<Product id="APS" name="APS-11.1.2" displayVersion="version">
  <Server name="Oracle Hyperion Provider Services" context="http://webServerHost:webServerPort/aps/SmartView"></Server>
</Product>
<Product id="HP" name="HP-11.1.2" displayVersion="version">
</Product>
<Product id="HFM" name="HFM-11.1.2" displayVersion="version">
</Product>
<Product id="RAFramework" name="RAFramework-11.1.2" displayVersion="version">
  <Server name="Reporting and Analysis Framework" context="http://webServerHost:webServerPort/raf framework/browse/listXML"></Server>
</Product>
<Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2" displayVersion="version">
  <Server name="Oracle Hyperion Strategic Planning, Fusion Edition" context="http://webServerHost:webServerPort/StrategicPlanning/SmartView"></Server>
</Product>
</res_GetProvisionedDataSources>
```

- [Connection File Syntax](#)
- [Connection File Example](#)
Connection File Example

The following example includes an entry for each provider type and also includes an entry for accessing help from an organization's internal web server:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<res_GetProvisionedDataSources>
  <Product id="APS" name="APS-11.1.2" displayVersion="11.1.2.2.500">
    <Server name="Oracle Hyperion Provider Services" context="http://abcsvr.xyzco.com:19000/aps/SmartView"></Server>
  </Product>
  <Product id="HP" name="HP-11.1.2" displayVersion="11.1.2.2.000">
  </Product>
  <Product id="HFM" name="HFM-11.1.2" displayVersion="11.1.2.2.300">
  </Product>
  <Product id="RAFramework" name="RAFramework-11.1.2" displayVersion="11.1.2.2.000">
    <Server name="Reporting and Analysis Framework" context="http://abcsvr.xyzco.com:19000/raframework/browse/listXML"></Server>
  </Product>
  <Product providerType="ExtensionProvider" id="HSF" name="HSF-11.1.2" displayVersion="11.1.2.2.00.2266">
  </Product>
  <Product providerType="ExtensionProvider" id="27EE9B0D-D5F5-42c9-AFC5-44FEA770C693" name="OBI EE-11.1.1.7" displayVersion="version">
  </Product>
  <Product id="EPRCS" name="Enterprise Performance Reporting Cloud Service" displayVersion="version">
    <Server name="EPRCS" context="http://webServerHost:webServerPort/epm/SmartView"></Server>
  </Product>
  <helpurlcontext>http://abcxyzcowebserver:12345/user_documentation/smartview_help/</helpurlcontext>
  <UPK>http://download.abcxyzco.com/ocomdocs/PlayerPackage/data/toc.html</UPK>
</res_GetProvisionedDataSources>
```
Installing and Configuring Help Locally or on a Web Server

Related Topics:

About Installing Help Locally or on a Web Server
Setting Up Help Locally or on a Web Server
Optional Local Help Configuration via the Shared Connections XML File

About Installing Help Locally or on a Web Server

After installing Oracle Smart View for Office, the online help is accessed from a URL hosted on the Oracle.com website. This is the default behavior for Smart View, and no changes are required by users to launch help.

However, you may require that the help be installed locally or on a web server in your organization. Some examples for the need to access help from a location other than Oracle.com are:

• Help files must be installed on a local drive on an individual’s computer for Section 508 accessibility purposes.

• Internet access limitations; for example, your users only have access to URLs on your organization’s intranet.

To accommodate the above types of cases, a help zip file can be downloaded from My Oracle Support. You unzip the help to a local drive or web server, and then modify the Smart View properties.xml file to point the help location.

Note:

Depending on your requirements, you may also want to specify the <helpurlcontext> tag in a shared connections XML file, as described in Setting Up the Shared Connections XML File of Accessing Shared Connections from an XML File. Refer to Optional Local Help Configuration via the Shared Connections XML File for more information.

Setting Up Help Locally or on a Web Server

To install and configure Oracle Smart View for Office help locally or on a web server:

1. Obtain the help zip file for this release from My Oracle Support.
2. Extract the contents to either a local folder on the computer where Smart View is installed or to a folder accessible by your users on an HTTP web server in your organization.

For example:

- Extract the contents locally to:
  
  C:\Oracle\SmartView\smartview_help

  The extraction adds an additional folder named smartview_help. The result is:
  
  C:\Oracle\SmartView\smartview_help

- Extract the contents to a web server:
  
  http://webServerHost:webServerPort/pathToHelpFiles

  The extractions adds smartview_help after pathToHelpFiles. The result is:
  
  http://webServerHost:webServerPort/pathToHelpFiles/smartview_help

Under the smartview_help folder, there are 28 language folders; for example:

C:\Oracle\SmartView\smartview_help
  \ar
  \cs
  \da
  \de
  \el
  \en
  \es
  \fi
  \fr
  \fr_CA
  \he
  \hu
  \it
  \ja
  \ko
  \nl
  \no
  \pl
  \pt
  \pt_BR
  \ro
  \ru
  \sk
  \sv
  \th
  \tr
  \zh_CN
  \zh_TW

The following language folders contain translated versions of the Smart View help:

\de
\es
\fr
\it
The remaining language folders contain the English version of the help. When you run Smart View in one of those languages (for example, Swedish) and you click a button for Help, the English help is displayed.

Additionally, the English folder contains a copy of the help in PDF format, smartview_user.pdf.

3. Modify the `helpurlcontext` property in the Smart View properties.xml file:
   a. In your Smart View installation, navigate to the SmartView\cfg folder.
   b. Make a backup copy of the original properties.xml file.
   c. Open `properties.xml` for editing.
   d. Modify the `helpurlcontext` property, providing the path to the folder that is parent to the language folders using the following syntax:

   • If installing locally, provide the path to the folder that is parent to the language folders using the following syntax:

     `<helpurlcontext>file://parent_language_folder_path</helpurlcontext>`

     Tip:

     Use forward slashes in the syntax and ensure that you enter a final forward slash (/) after the parent language folder path that you provide.

     Using the example from step 2, after extracting the zip contents to C:\Oracle\SmartView, the smartview_help folder is the parent folder of the language folders. Thus, you would modify the `parent_language_folder_path` placeholder as follows:

     `<helpurlcontext>file:///C:/Oracle/SmartView/smartview_help/</helpurlcontext>`

     • If installing on a web server, provide the path to the folder that is parent to the language folders using the following syntax:

     `<helpurlcontext>http://webServerHost:webServerPort/pathToHelpFiles/smartview_help/</helpurlcontext>`

     Tip:

     Use forward slashes in the syntax and ensure that you enter a final forward slash (/) after the parent language folder path that you provide.

     Using the example from step 2 and substituting `user_documentation` for `pathToHelpFiles`, after extracting the zip contents to http://abcxyzco.com:12345/user_documentation, the smartview_help folder is the parent folder of the language folders. For example:
4. Restart your Microsoft Office applications and access the help from the Smart View ribbon.

5. Repeat this procedure for each computer that requires Smart View local help.

Optional Local Help Configuration via the Shared Connections XML File

In a new installation, Oracle Smart View for Office help is available as soon as you start Excel. You do not need to be connected to a Smart View provider in order to view the help. After making the changes to the properties.xml file described in this chapter, help is accessed from the help location you indicate.

If you are also planning to access shared connections from an XML file (as described in Accessing Shared Connections from an XML File), AND you require an alternative location for the help, note the following:

- You can add the <helpurlcontext> tag to the shared connections XML file. The help location you specify in the shared connections XML file overrides the help location specified in properties.xml once you click the Shared Connections button in the Smart View Panel. This is true whether or not you modify the <helpurlcontext> tag in properties.xml.

- If you do not add or specify the <helpurlcontext> tag to the shared connections XML file, then the local help defined in the properties.xml file will ALWAYS be used and is available as soon as you start Excel.
Diagnostics Tools

When an issue arises while using Oracle Smart View for Office that you cannot resolve on your own, you can use the Smart View Diagnostic tools in the Diagnostics group in the Smart View ribbon to create and collect log files and screenshots to send to Oracle Support. When you are finished collecting diagnostic data, you use the diagnostic tools to zip up the files. Then you transmit the ZIP file to Oracle Support for analysis. The log files and screenshots are used by Oracle Support to troubleshoot and resolve your issue.

You can customize certain features of Smart View Diagnostic tools; for example:

- Hide data values in an Office document.
- Hide member names in an Office document.
- Direct the diagnostics output files to a folder other than the default.
• Allow automatic screenshots for each warning or error message that is displayed.

See the "Smart View Diagnostics" chapter of the Oracle Smart View for Office User’s Guide for more information on the Diagnostics tools.

Installation and Languages

The Oracle Smart View for Office installer uses the language set in the Format field of the Windows Region and Language dialog box, Formats tab. This language also becomes the default language when running Smart View.

After installation, anytime you change the Smart View language setting (Options dialog box, Advanced tab), Smart View remembers the new setting on each subsequent launch of Excel.

To return Smart View to the default language, you can use either of the following methods in the Options dialog box, Advanced tab:

• Click the Reset button.

• Select the first option in the Language drop-down list. This is always Default, which is the language specified in the Region and Language dialog box, Formats tab

After uninstalling and then reinstalling, Smart View reverts to the language specified in the Windows Region and Language dialog box, Formats tab, and not the last language specified in the Smart View Options dialog box, Advanced tab.

Windows, Office, and Smart View Locale Settings

On each Oracle Smart View for Office client machine, the following locale settings should match:

• Smart View language option

• Microsoft Office language

• Windows Regional Settings

• Windows operating system

Running Smart View in a language other than the language of the machine’s Windows operating system, system locale, or Office language, may result in incorrect data being returned. For example, if the Windows operating system, system locale, and Office language are English, and you run Smart View in Russian, reports or chart data may display incorrectly.

Error When First Launching Excel After Installing Smart View

After installing Oracle Smart View for Office and launching Excel for the first time, you may get an error message similar to the following: "Unable to set the installed property of the add-in class."

Workarounds: Enable the Smart View Excel add-in using one of the following methods:

Trust Center Method

1. Perform the task appropriate for your Office version:
• 2013 and 2010: Go to File, then Options, and then Trust Center.
• 2007: Click the Office button in the top left corner of Excel, then select Excel Options, and then Trust Center.

2. Click the Trust Center Settings button.
3. In the left pane, select Trusted Locations.
4. Click Add new location to launch the Microsoft Office Trusted Location dialog box.
5. In Path, enter: C:\Oracle
6. Click OK.
7. Click OK to close the Trust Center, and then click OK to close Excel Options.

COM Add-ins Method:
1. Perform the task appropriate for your Office version:
   • 2013 and 2010: Go to File, then Options, and then Add-ins.
   • 2007: Click the Office button in the top left corner of Excel, then select Excel Options, and then Add-ins.
2. From Manage, select COM Add-ins, and then Go.
3. In COM Add-ins, select the check box to enable the Oracle Smart View for Office add-in, and click OK.

Internet Explorer Compatibility View Settings for Financial Reporting

When running a Oracle Hyperion Financial Reporting report from Oracle Smart View for Office, a web control is called that causes this error to display: "The product does not support compatibility view. Contact your system administrator to help configure your settings."

By default, the web control runs in compatibility mode, triggering the compatibility message.

Workarounds:
• Click to clear the message, and the report preview displays as expected.
• To avoid the compatibility message, modify the Windows Registry as follows.

For 32-bit Office:
In [HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Microsoft\Internet Explorer\MAIN\FeatureControl\FEATURE_BROWSER_EMULATION], add the following three DWORD (32-bit) values:

"EXCEL.EXE"=dword:00008000
"POWERPNT.EXE"=dword:00008000
"WINWORD.EXE"=dword:00008000

For 64-bit Office:
Add the three DWORD values for Excel, PowerPoint, and Word in
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Internet Explorer\MAIN\FeatureControl\FEATURE_BROWSER_EMULATION].

The values must match your installed version of Internet Explorer. If you are unsure which entry to use, then use the 32-bit Office values noted above.

Internet Explorer 8:

"EXCEL.EXE"=dword:00008000
"POWERPNT.EXE"=dword:00008000
"WINWORD.EXE"=dword:00008000

Internet Explorer 9:

"EXCEL.EXE"=dword:00009000
"POWERPNT.EXE"=dword:00009000
"WINWORD.EXE"=dword:00009000

Internet Explorer 10:

"EXCEL.EXE"=dword:00010000
"POWERPNT.EXE"=dword:00010000
"WINWORD.EXE"=dword:00010000

Internet Explorer 11:

"EXCEL.EXE"=dword:00011000
"POWERPNT.EXE"=dword:00011000
"WINWORD.EXE"=dword:00011000

Working with Custom HTML-based Login Forms

If you are using a custom HTML-based login form instead of the default Oracle Access Manager login form, ensure that the source of the custom form includes the string loginform. This is required for Oracle Smart View for Office integration with Oracle Access Manager to work.

Browser Settings When Working with XML Files on HTTP Server

Internet Explorer may cache XML files posted on an HTTP server and referenced by Oracle Smart View for Office. This can cause problems when using the following Smart View functionality:

- Accessing shared connections from an XML file

  This is the XML file posted on an HTTP server and noted in the Shared Connections URL field of the Smart View Options dialog box. If you plan to access online help from a local drive or internal web server, this file can also specify the location of the help.

- Updating extensions

  Smart View references the UpdateList.xml file that is posted on an HTTP server when Smart View end users install, update, and remove extensions in the Extensions tab of the Options dialog box.

Complete the steps in this topic to clear the browser cache so that the latest version of the XML file is used for the purposes noted above.
To clear the cache so that Smart View is accessing the latest XML file version posted on an HTTP server, set the following options in Internet Explorer:

1. Select **Tools**, then **Internet Options**.
2. In the **General** tab, **Browsing history** group, select **Settings**.
3. In the **Check for newer versions of stored pages** section, select **Every time I visit the webpage**, and then click **OK**.
4. In the **Internet Options** dialog box, select the **Advanced** tab.
5. In the **Security** section, select the **Empty Temporary Internet Files folder when browser is closed** option.
6. Click **OK** to close **Internet Options** and restart the browser.

**Flickering Issues on Office 2013 and Office 2016**

When using Smart View with Microsoft Office 2013 or 2016, 32-bit or 64-bit, flickering occurs with the POV toolbar and the Smart View Panel. The flickering is likely caused by changes in Excel 2013 and Excel 2016.

To reduce flickering, Oracle advises that you take the following actions:

- Ensure that you have installed one of the following Microsoft updates:

  To check if an update is already installed on your machine, go to Control Panel, then Programs and Features, and then “View installed updates.” In the Search box, enter the KB number for each update; for example, enter KB2863880, and then enter KB282563. If one of the updates is installed, then you do not need to install any other update. If no results are returned for either, then you must install one of the updates.

- Add two DWORD values in the Windows Registry (described in the sections below).
  - **Disable Window Transitions (DisableWindowTransitionsOnAddinTaskPanels)**
  - **Disable Office Animations (DisableAnimations)**

**Disable Window Transitions (DisableWindowTransitionsOnAddinTaskPanels)**

To improve the user experience, you may enable the DWORD value DisableWindowTransitionsOnAddinTaskPanels for Office 2013 and 2016. To do this, add the DisableWindowTransitionsOnAddinTaskPanels DWORD value to the Toolbars key in the Windows Registry as follows:

- **Key Name:**
  
  ```
  [HKEY_CURRENT_USER\Software\Microsoft\Office\<OfficeVersion>\Common\Toolbars]
  ```

- **New DWORD and Value:**
  
  ```
  "DisableWindowTransitionsOnAddinTaskPanels"=dword:1
  ```
To add the new DisableWindowTransitionsOnAddinTaskPanes DWORD value to the Toolbars registry key:

1. Click **Start**, click **Run**, type `regedit` in the **Open** box, and then click **OK**.
2. Depending on your Office version, locate and then select the following registry key:
   - **Office 2013:**
     ```
     HKEY_CURRENT_USER\Software\Microsoft\Office\15.0\Common\Toolbars
     ```
   - **Office 2016:**
     ```
     HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Common\Toolbars
     ```
3. From the **Edit** menu, select **New**, and then select **DWORD Value**.
4. Type `DisableWindowTransitionsOnAddinTaskPanes`, and then press **Enter**.
5. In the **Details** pane, right-click `DisableWindowTransitionsOnAddinTaskPanes`, and then select **Modify**.
6. In the **Value** data box, type `1`, and then click **OK**.
7. Exit Registry Editor.
8. Restart Excel.

### Disable Office Animations (DisableAnimations)

To further improve the user experience, you may disable Office Animations for Office 2013 and 2016 by adding a key and DWORD value to the Windows Registry. To do this, create the Graphics key and DisableAnimations key value as follows:

- **Key Name:**
  ```
  [HKEY_CURRENT_USER\Software\Microsoft\Office\<OfficeVersion>\Common\Graphics]
  ```
- **New DWORD and Value:**
  ```
  "DisableAnimations"=dword:00000001
  ```

To create the registry key, Graphics, and add the new DisableAnimations DWORD value:

1. Click **Start**, click **Run**, type `regedit` in the **Open** box, and then click **OK**.
2. Locate and then select the following registry key:
   - **Office 2013:**
     ```
     HKEY_CURRENT_USER\Software\Microsoft\Office\15.0\Common\
     ```
   - **Office 2016:**
     ```
     HKEY_CURRENT_USER\Software\Microsoft\Office\16.0\Common\
     ```
3. From the **Edit** menu, select **New**, and then select **Key**.
4. Type **Graphics**, and then press **Enter**.
5. From the **Edit** menu, select **New**, and then select **DWORD Value**.

6. Type **DisableAnimations**, and then press **Enter**.

7. In the **Details** pane, right-click **DisableAnimations**, and then click **Modify**.

8. In the **Value** data box, type 00000001, and then click **OK**.

9. Exit Registry Editor.


---

**Issues When Starting Excel in Automation Mode**

**Problem**
In some cases, third-party software that automates Excel processes, such as exporting to Excel, may cause issues with Excel and a conflict with Oracle Smart View for Office.

**Solution**
To disable Smart View when Excel is started in automation mode, you may enable "DisableInAutomation" by adding a key and key value to the Windows Registry. To do this, create the Options key and DisableInAutomation key value as follows:

- **Key Name:**
  
  [HKEY_CURRENT_USER\Software\Oracle\SmartView\Options]

- **Key Value:**
  
  "DisableInAutomation"=dword:00000001

  When set to 00000001, Smart View is disabled when Excel is started in automation mode. Smart View starts correctly when Excel is started manually, outside of an automated process.

  When set to 0 or not created at all, then Smart View is enabled and starts when Excel is started in automation mode, which may cause issues. Smart View starts correctly when Excel is started manually, outside of an automated process.

**Creating the Registry Key and Key Value**
To create and update the registry key, Options:

1. Click **Start**, click **Run**, type regedit in the **Open** box, and then click **OK**.

2. Locate and then select the following registry subkey:

   [HKEY_CURRENT_USER\Software\Oracle\SmartView\]

3. From the **Edit** menu, select **New**, and then select **Key**.

4. Type **Options**, and then press **Enter**.

5. From the **Edit** menu, select **New**, and then select **DWORD Value**.

6. Type **DisableInAutomation**, and then press **Enter**.

7. In the **Details** pane, right-click **DisableInAutomation**, and then click **Modify**.

8. In the **Value** data box, type 00000001, and then click **OK**.

   The value, 00000001, enables the **DisableInAutomation** key.
Note:
If a zero value is entered, then this option is disabled.

9. Exit Registry Editor.


**Slowness with Extension Options Dialog Box**

When opening the **Extensions** tab of the **Options** dialog box or when checking for extension updates, if your system seems to be taking a long time to complete these tasks, ensure that the machine has access to the internet.

**Performance and Memory Usage Considerations for Smart View with Excel**

Oracle Smart View for Office is a Microsoft Office add-in. As an add-in, it is loaded into the Microsoft Excel process. When a report is imported into Excel through Smart View, the Excel process consumes memory and this can negatively impact performance.

For example, instances of grids and forms, objects in the Undo buffer, XML parsing, etc., will cause the Excel process to consume memory. Because of this, the Excel or machine memory limit becomes the Smart View memory limit as well. This can severely impact performance.

There is no memory configuration parameter in Smart View to manage this.

Excel 32-bit and 64-bit have different memory limits:

- For Excel 32-bit, the maximum memory limit, or RAM, is 2GB.
  Oracle testing showed that when Excel 32-bit memory usage reaches beyond 700 MB, Excel can behave abnormally and can terminate unexpectedly.

- The 64-bit versions of Excel are not constrained to 2 GB of RAM, as are the 32-bit Office applications.
  For large reports, Oracle recommends using 64-bit Excel. Or consider reducing the data being sent to Smart View by reducing the number of rows, columns, and POVs in the reports.

Oracle suggests that you consider taking some or all of the actions listed below in an effort to limit memory usage and improve performance.

The following actions can help to limit memory usage:

1. Ensure that these options are enabled in the Smart View **Options** dialog box, **Advanced** tab:
   - **Reduce Excel File Size**
   - **Improve Metadata Options**

2. In the **Options** dialog box, **Advanced** tab, set **Number of Undo Actions** to ’0’ (zero), if possible, or to a low number such as 1 or 2.

4. In the Options dialog box, Formatting tab, if you have selected the Use Excel Formatting option, then you should clear the Move Formatting on Operations option.

5. In the Formatting tab, clear the Adjust Column Width option.

6. In the Options dialog box, Extensions tab, disable any unneeded extensions.

7. In Excel, to improve performance and stability, disable or uninstall any unused add-ins. For example, disable or uninstall the Oracle Essbase Spreadsheet Add-in. Other possible add-ins to disable or uninstall are, for example, Adobe PDF, WebEx, or Send to Bluetooth.

8. Reduce the workbook size.

9. Limit the data imported to Excel:
   a. Use prompts, filters, POVs, or other ways to reduce the data returned back to Smart View.
   b. Enable the Suppress Rows and Suppress Columns options in the Data Options tab of the Smart View Options dialog box.

The following actions can help to improve performance, as well as limit memory usage:

1. In the Options dialog box, Advanced tab, set Number of Undo Actions to ’0’ (zero), if possible.

2. In the Options dialog box, Member Options tab, ensure that these options are cleared:
   a. Preserve Formulas and Comments in ad hoc options
   b. Formula Fill

   Clear these options only if you do not need to preserve formulas or comments during ad hoc operations.

Also, refer to the following documentation from Microsoft, "Excel 2010 Performance: Performance and Limit Improvements":

**Smart View HTTP Session Timeout**

HTTP session timeouts can occur, for example, when working with large queries that take a long time to run, or when you’re experiencing slower internet connections.

To avoid HTTP session timeouts, you may add the following Windows Registry DWORDS to the Internet Settings key:

- Key Name:
  HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings

- Key Values:
- DWORD: ReceiveTimeout
  Value data: *value in milliseconds*
- DWORD: KeepAliveTimeout
  Value data: *value in milliseconds*
- DWORD: ServerInfoTimeout
  Value data: *value in milliseconds*

For example, 900000 milliseconds is the equivalent of 15 minutes. Adjust the timing according to your requirements.

As a guideline, 900000 milliseconds is the equivalent of 15 minutes.

To add the timeout key values to the Internet Settings registry key:

1. Ensure that all Office applications, including Outlook, are closed.
2. Launch the Windows Registry Editor.
3. Locate and then select the following registry subkey:
   
   `HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Internet Settings`
   
4. Add the three DWORD key values, ReceiveTimeout, KeepAliveTimeout, and ServerInfoTimeout:
   
   a. From the Edit menu, select New, and then select DWORD Value.
   
   b. Type the DWORD name, and then press Enter.
   
   c. In the Details pane, right-click DWORD you added in step 4.b, and then select Modify.
   
   d. In the Value data text box, type the timeout value in milliseconds, select Decimal, and then click OK.
   
   e. Repeat step 4.a through step 4.d for each of the three required DWORD key values.

5. Exit Registry Editor.

**Duplicate Queries in Word Slow to Refresh**

In some Word documents containing a large number of queries and created prior to Oracle Smart View for Office release 11.1.2.5.520, performance may be an issue when refreshing the data in the document. In some cases, instead of re-using existing queries where appropriate, each Smart View data point in the Word document is treated as a separate query. The result is that Refresh operations can be very slow.

If the document contains many duplicate queries (that is, queries with the same name), the duplicate queries are displayed in the Document Contents pane in Word. For example, Document Contents might look like this:
The duplicate queries are SmartView14446361770 and SmartView14446541490. You can run Visual Basic macro below to remove the duplicate queries:

```
Sub DeleteExtraQueries()
    ' DeleteExtraQueries Macro
```

After running the macro, the two queries, SmartView14446361770 and SmartView14446541490, appear only once in Document Contents:

![Document Contents](image)

**Issues with Dynamic Data Exchange Option in Excel**

Various issues may arise when the Excel option, Ignore other applications that use Dynamic Data Exchange (DDE), is selected. For example, there are problems launching Excel, launching Excel files from outside of Excel, and using the Export in Query Ready Mode option from a browser to export balances from Oracle Hyperion Financial Reporting.

**Workaround:** Click the Microsoft Office Button (upper left corner of Excel), and then click Excel Options. In the Advanced category, scroll down to the General options,
and then clear the **Ignore other applications that use Dynamic Data Exchange (DDE)** check box. Restart Excel.

**Transition Navigation Keys Not Supported**

Oracle Smart View for Office does not support Excel’s **Transition navigation keys** option.

Due to a Microsoft limitation, many of the Microsoft APIs that Smart View depends on for both Smart View and Excel functionality do not work when the **Transition navigation keys** option is enabled. For example:

- In Excel, copy/paste, macros, automation API calls do not work correctly.
- In the Planning Admin extension, member formula formatting in the Smart View Dimension Editor does not display correctly; formulas have incorrect syntax when submitted to Oracle Hyperion Planning.

In order to ensure the best performance possible, Smart View requires the following:

- The Excel option, **Transition navigation keys**, must be cleared.
- The **Smart View** option, **Improve Metadata Storage**, must be enabled (by default, this option is enabled).

**Excel Looks for HsTbar.xml File After Uninstall**

Sometimes, after uninstalling Oracle Smart View for Office and subsequently launching Excel, Excel may still try to locate the Smart View HsTbar.xla file.

To correct this, you must edit the Windows Registry.

To edit the Windows Registry to keep Excel from looking for HsTbar.xml file after uninstalling Smart View:

1. Open the Windows Registry Editor (enter `regedit` in a command window).
2. Locate this key:

   \HKEY_CURRENT_USER\Software\Microsoft\Office\<OfficeVersion>\Excel\Options

3. Delete the **OPEN** or **OPEN<n>** entry where the value in the **Data** column contains HsTbar.xla.

   For example:

   C:\Oracle\SmartView\bin\HsTbar.xla

   When there are multiple OPEN entries, perform these steps:

   a. Delete all **OPEN** entries where the **Data** column value contains HsTbar.xla.
   b. Rename all remaining **OPEN<n>** entries, maintaining their sequential values.

   For example, here are six **OPEN** entries, where two of the entries, **OPEN** and **OPEN4**, contain HsTbar.xla in the **Data** column.

<table>
<thead>
<tr>
<th>Name</th>
<th>Value in Data Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN</td>
<td>Contains HsTbar.xla</td>
</tr>
<tr>
<td>OPEN1</td>
<td>Does not contain HsTbar.xla</td>
</tr>
</tbody>
</table>
OPEN2    Does not contain HsTbar.xla
OPEN3    Does not contain HsTbar.xla
OPEN4    Contains HsTbar.xla
OPEN5    Does not contain HsTbar.xla

Delete the OPEN and OPEN4 entries, and then rename the remaining entries as follows, maintaining their sequential order:

- Rename OPEN1 to OPEN
- Rename OPEN2 to OPEN1
- Rename OPEN3 to OPEN2
- Rename OPEN5 to OPEN3

The remaining entries are:

<table>
<thead>
<tr>
<th>Name</th>
<th>Value in Data Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPEN</td>
<td>Does not contain HsTbar.xla</td>
</tr>
<tr>
<td>OPEN1</td>
<td>Does not contain HsTbar.xla</td>
</tr>
<tr>
<td>OPEN2</td>
<td>Does not contain HsTbar.xla</td>
</tr>
<tr>
<td>OPEN3</td>
<td>Does not contain HsTbar.xla</td>
</tr>
</tbody>
</table>
This appendix describes limitations you may encounter while working with Oracle Smart View for Office.

**General**

- In PowerPoint, you may not be able to access Oracle Smart View for Office functions through Microsoft smart tags.
  
  **Workaround:** Retype “smartview” (the Smart View smart tag) to cause PowerPoint to reload the smart tag.

- When you open a saved free-form workbook and change the Member Name Only or Member Name and Description setting in the Options dialog box before refreshing, the member display options do not work.
  
  **Workaround:** Refresh the grid before entering Member Name Only or Member Name and Description.

- Because of a Microsoft Word limitation, if the value of the system-defined option "List separator" is set to one of the regular expression anchor characters (including but not limited to "^" and "$"), Word might fail to insert fields of type "Formula," which will cause failure of copy and paste.
  
  **Workaround:** Go to Control Panel, then Regional and Language, then Options, then Standards and Formats, then Customize, and then Numbers, and change the list separator option.

- Do not change the file extension when you save an Excel workbook with the **Get** function that has been retrieved through simulation workbooks in the Smart View Panel.

- Sheet names may be truncated if they are longer than 31 characters; this is an Excel limitation.

- To use Outlook with Smart View, Visual Basic Scripting Support must be installed and Run From My Computer must be selected in Outlook. See Outlook product documentation for information.

- In Microsoft Word, slider controls may be resized in reports created in the Report Designer.

- When you perform drill-through from an Oracle Essbase Studio-sourced cube to FDM, if the EPM System Single Sign-On (SSO) token expires before the sessions of all products involved expires (Workspace, Provider Services, Essbase, Essbase Studio, FDM), the following message is displayed: “Error: An error occurred logging on to the system using single sign-on. Please contact your administrator. Error: 2067 -- You do not have access to the application!”
**Workaround:** Log in again to Oracle Hyperion Enterprise Performance Management Workspace from Smart View.

- When you delete a worksheet containing a reporting object from the Report Designer, Excel may terminate abruptly. This is a Microsoft issue.

- Sliders in Smart Slice reports do not display properly after the report is closed and reopened. This happens because of a Microsoft security setting for ActiveX controls and OLE objects in Office 2007. See the Microsoft support site for information about working around this issue.

- If you use Microsoft COM or Automation Add-ins to open Excel, the Smart View ribbon or menu is not displayed, and you cannot automate Smart View. This happens because Smart View cannot be loaded through automation.

  **Workaround:** Open Excel from EXCEL.EXE located in the Office installation folder, typically C:\Program Files\Microsoft Office\Office12. This workaround is effective only if you do not need to do any further automation. For more information and a complete workaround, see Knowledge Base Document 1453237.1, "SmartView Functionality Changed: Cannot Automate SmartView from Another Program," available from My Oracle Support.

- In Smart Query, no results may be returned when you use an equals sign (=) in a filter definition based on value. This happens if the decimal places displayed for numbers in Excel in Smart View is different from that set in Oracle Essbase for the connection.

  **Workaround:** Use the same "decimal places displayed for numbers" setting in both Excel and Essbase.

- When working with larger workbooks, or performing an operation that results in a large data set, a "not enough resources" error may occur.

  **Workarounds:**
  - Break up your workbook into smaller workbooks.
  - Upgrading to Office 64-bit may resolve the issue.

- When inserting a Smart Slice into a report and refreshing the sheet, the report table is not refreshed and the table data is not visible.

  **Workaround:** If the data is not visible, click on the first few empty cells; data will then start displaying.

- Zooming out after performing a zoom in can leave blank rows on the worksheet.

  **Workaround:** This is not a specific Smart View issue but may be related to excess formatting not being removed by Excel. Oracle recommends trying the following Microsoft workarounds:
  - Reset the last cell in Excel
  - Download and use the Microsoft Excel Excess Formatting Cleaner Add-in

- On computers where Smart View is installed, an error occurs when updating links in PowerPoint that were copied from Excel to PowerPoint.
Essbase

- In the Query Designer, Oracle Smart View for Office generates a syntax error when you perform a descendants or top/bottom query on a member whose name contains a dot (\).

- Calculation scripts that run from Essbase may not run from Smart View. This can happen if you have restricted calculation access in Smart View. Calculation scripts are run against the connected database.

- When you perform an Undo, only the previously selected POV is saved, and recently selected members are removed.

  **Workaround:** instead of using Undo, use Pivot to POV, which will replace all members on that dimension to the POV.

- When you perform Smart View operations in a Smart Slice and refresh, you may get an Assertion Failed error message if you try to close Excel by clicking the X in the upper right corner. The message is harmless; you can click OK to close it.

- Using Find in the Member Select dialog box may cause Excel to perform excessively slowly or freeze if the dimension contains more than approximately 100,000 members.

- If you use merged cells, you may encounter the following issues:
  - When there are merged cells in a row dimension, proper merging is not maintained when you zoom in on the top cell of the innermost row dimension.
  - When you use the *Formula/Format Fill* option with merged cells in a row dimension, *Formula/Format Fill* does not fill cells properly when you zoom in on the innermost row dimension.

  The POV must contain more than one dimension. If there is only one dimension on the POV, it will be pivoted to the grid when you refresh.

- The Function Builder cannot distinguish among substitution variables with the same name.

- Numerical values entered into cells that are outside the grid may be lost upon refreshing.

- If you add members in a column left of a column of blank cells, the new members may be lost after you refresh. This happens because the blank cells are not valid intersections.

- If you are connected to an earlier version of Oracle Essbase, custom members that you create using Smart Query may not be applied when you switch from a Smart Query worksheet to ad hoc analysis.

- Member names that contain a hash mark (#) may cause errors.

  **Workaround:** Do not use hash marks in member names.

- Smart View does not support dual-monitor operation. For example, in Microsoft Word and PowerPoint, the POV control in Smart Slices may not display properly when you are connected to more than one monitor.
Planning

- If you have cascaded a report created from a new Smart Slice containing at least one function grid and a control (slider or POV) across an Excel workbook, Excel may terminate abruptly if you choose not to save the cascaded report.

- Oracle Smart View for Office does not permit the use of #Missing in Calc Manager rules, even if the variable is set to permit #Missing.

- In data forms previously saved in an Excel workbook, expanding a member may result in data that is incorrectly displayed as zero or No Access.
  **Workaround:** To display the correct data, refresh the worksheet or submit data.

- Tasks imported into Outlook via Smart View can cause errors if Outlook is configured for Oracle Beehive.
  **Workaround:** In Outlook Send/Receive settings, select None for the Task List folder. See the Outlook documentation for information.

- Read-only Dynamic Calc cells may be displayed incorrectly as writable in offline data forms with the suppress missing option set to true.

- The Offline wizard continues to be displayed in English when you change to a different language in Smart View.

- Oracle Hyperion Planning servers added via “Add new server” from the Smart View Panel are not displayed in the Smart View Panel in Outlook.

- If Suppress Rows is enabled in the Planning data form, new rows of data created in offline mode by means of a business rule are not saved when you synchronize back to the server.

- If the option Keep data changes made in offline mode is unselected, then any changes made in an offline data form should be overwritten with data from the Planning web when you refresh. However, if the suppress missing rows option is selected for the data from, these changes are retained when you refresh.

- In the Outlook 2007 shortcut menu for tasks, the Assign Task and Mark Complete items may work only intermittently.

- Closing the Smart View Panel in Outlook may take a long time after you open a task from a large task list. The reason is that task lists are always refreshed upon closing, and the time needed to refresh depends, in part, on the number of tasks in the task list.

- Starting with Release 11.1.2.1, Smart View cannot be connected to Planning through Provider Services. You can connect to Planning directly.

Financial Management

- Chart data is not properly updated upon Refresh if the data for the current intersection is #Invalid.

  **Workaround:** Change the slider or POV to a valid data point that displays different data, and then perform a Refresh. The chart is properly updated.
• POV controls inserted into a report may be disabled when you close and reopen the document containing the report. This happens when ActiveX controls are disabled.

  **Workaround:** Enable ActiveX controls in Microsoft Office.

• A connection timeout occurs when performing a refresh in the latest version of Smart View when connected to the 11.1.2 version of Oracle Hyperion Financial Management. This issue is addressed starting with Financial Management 11.1.2.2.

• Problems with the column suppression options are causing Financial Management grids to open with a “grid is not well formed” error.

• When performing ad hoc analysis while connected to a Financial Management data source, with the Suppress Columns options "No Data/Missing" and "Zero" selected, after clicking Refresh, the corresponding columns are not suppressed and still appear in the sheet.

**Reporting and Analysis**

• Filters are not updated in POV toolbar after you edit them; however, data is changed successfully.

• If you have an open Excel document when you export a Oracle Hyperion Financial Reporting report in query-ready mode to Excel, the open Excel document will be overwritten without warning.

  **Workaround:** Save and close any Excel documents before exporting.

• Oracle Hyperion Web Analysis reports imported from Oracle Hyperion Enterprise Performance Management Workspace to PowerPoint 2010 do not open correctly.

  **Workaround:** Save the report file as an HTML file. Then open directly in PowerPoint; do not try to import from EPM Workspace. This issue does not apply to versions of PowerPoint other than 2010.

• When you export an Oracle Hyperion Interactive Reporting report from Internet Explorer into Oracle Smart View for Office 11.1.2.1.x, the Smart View ribbon disappears in Excel.

  **Workaround:** Open Excel before exporting from Internet Explorer.

• Autodeployment does not work for Oracle Hyperion Reporting and Analysis release 11.1.1.4 or earlier.

**FDM**

Oracle Hyperion Financial Data Quality Management does not support alias tables for Oracle Essbase drill-through.

**Enterprise Performance Reporting**

• Member names that contain a hash mark (#) may cause errors.

  **Workaround:** Do not use hash marks in member names.

• Oracle Enterprise Performance Reporting Cloud does not support the following Oracle Smart View for Office functionality:
– Formula preservation and formula fill
– Cell Styles
– Smart Query
– Submit Data
– Cascading
– Display Member Name and Alias
– Member Information
– Smart Slices